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What is A-Train 8? ▲TOP

A-Train 8 is a simulation game which
combines the enjoyment of running a railway
company with the thrill of creating your own
city.
You will become the owner of a budding
railway company, manage your trains and
develop subsidiary companies. Your
ultimate goal is to get your funds up to a
trillion.

Once you achieve the financial goal you will
clear the map that you are playing. However,
you can continue to play on any map even
after clearing it, allowing you to create your
own ideal city. 
On the other hand, if your funds remain in the
red for too long the game will end. You must
therefore pay close attention to your funds.

Game Mode and Map
Construction Mode ▲TOP

About Each Mode

A-Train 8 features two modes. In "Game Mode" you aim to get your funds up to a



trillion through development of a city and rail system. In "Map Construction
Mode" you can create entirely new game data which can then be used in Game
Mode.

Controls Unique to Map Construction Mode

In Map Construction Mode you can create an entirely new map for use in Game
Mode. The menu and basic controls are similar to Game Mode, but Map
Construction Mode also has the following unique features.

・Create Terrain
The Editor menu is added from the main
menu. This editor allows you to alter the
basic terrain of the map.

* The Project menu is not available during
Map Construction.

・Limits Off
Limited exclusively to Map Construction
Mode, the limitations on some controls are
released.

・"Trees," "Coast" and "Roads" can be
created from the Construction menu
・Materials are not required when
performing construction
・No money is required for any action
・The construction area for certain
buildings can be selected
・You can select the construction level of
high and super high buildings

・Creation of New Game Information
When registering a new game you can input the
following information.

・Game Name : Enter a name for the game
・City Name : Enter a name for the city
・Company Name : Enter a name for the
railroad company



・Game Description : Enter a description to
be displayed upon selecting the new game
・Funds Settings : Select the amount of
available funds at the start of the game
・Start Date Settings : Select the date at the
start of the game
・Start Weather Settings : Select the
weather at the start of the game

The Game Screen and Basic
Controls ▲TOP

① Main Menu
Click to open the selected menu

File : Start a new game, or save the game in progress.
Report : View information on your city and company.

Trains : Perform train-related commands, such as purchasing, placing,
removing and selling them.

Schedule : Use the Schedule Wizard to set up a schedule for stations and
points.

Track : Lay or remove track.
Station : Build or remove stations, station concourses and material depots.



Construction : Build or remove other types of building.
Project : Plan for construction of a bullet train or maglev in your city.
Market : Buy or sell stocks, borrow money and sell subsidiary companies.
Options : Alter various game settings.
Help : Open the online manual and official site.

② Grip
Displays the current status of the camera. You can also drag the grip to move the
camera around.

③ Tool Bar
Click to turn each tool on and off.

Display satellite view.
Display grip.
Display a grid overlaid on the
map.
Display information of selected
building.
Point the camera to the north.
Remove all menus from the
window.
Open the height cut menu.
Open the train tracking menu.
Display the stop timer.

④ Satellite
Displays an overview of the entire map. Click anywhere on the satellite image to
move to that location.

⑤ Date, Time, Funds
Display the current date, time and funds.
Click the time and in-game time will pause.
You can also adjust the speed at which in-game time passes using the slider
above the time.

All controls other than entering text are performed by clicking menus or buttons.
Hold the left button and drag the game screen or satellite image to move it
around. Hold the right button and drag the game screen to change the direction of
the camera.



Settings ▲TOP

Select "Program" from the "Start" button, then "ARTDINK" －"A-Train 8" and
then click on "A-Train 8 Settings" to open the computer settings for A-Train 8.
In "A-Train 8 Set Up" you can alter the display and sound options for A-Train 8.

・"Graphics" Tab

① Adapter
Displays the video card being used.

② Multi-Sampling
Performs anti-aliasing, smoothing out the display of lines during the game.
The higher the sampling rate the smoother the image will be, but the slower the
frame rate will fall.

None 6 Samples

③ Textures



Select depth of colouring for textures.
Normal selection is 32bit, low is 16bit.
If you don't have much VRAM you can select low to improve your frame rate.

Textures Low Textures Normal

④ Mipmap
Automatically create textures for buildings displayed in the distance, making
them appear cleaner.A
If you don't have much VRAM you can turn this "off" to improve your frame rate.
However if you have enough VRAM the frame rate will be higher with this
turned "on."

Mipmap OFF Mipmap ON

⑤ Draw Quality
When set to "High" mountains, water and other terrain will be gradated
according to height.
When set to "Normal" this gradation will not be applied, but the frame rate will
improve.

⑥ Boot in Full Screen Mode / Resolution
Check this box and the game will boot in full screen mode. (The game will boot
in a window if this box is not checked.)
If this box is checked you can also select the resolution and depth of colour (for
full screen mode.)

・"Sound" Tab

① Music
Set the volume of in game music.

② SE
Set the volume of in-game sound effects.

③ Only Use Software Mixing
If there is noise intruding on the in-game sound try turning this setting on.



Depending upon your settings this may reduce such noise.

・"Language" Tab

Select Language
You can choose the game text language from English, French, Italian, German
and Spanish.
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Starting the Game ▲TOP

Booting Up the Game

There are two ways in which you can initially boot the game.

・Double click the "A-Train 8" icon on your desktop.
・Select "Programs" from the "Start" button, then "ARTDINK," - "A-Train 8"
and then "A Train 8."

Start Menu

Once the game boots the opening will be displayed. Once the opening ends the
start menu will be displayed.

・Game Mode
New Game ： Start a new game using map data pre-loaded into the game.
Registered
Game ： Start a new game using data created in Map Construction.

Load ：Open previously saved data and continue play.
End ：Close the application.

・Map Construction Mode
Create New ： Edit a map, initially flat at height 2.
Revise
Registered ：Revise a map already registered for use as a new game.



Game
Load Map In
Progress ：Open a previously saved map in progress and continue

editing.
End ：Close the application

Ending the Game ▲TOP

Click on File from the main menu, then
"End" and then "End Without Saving" to a
display a message asking if you want to
return to the start menu.
However, when ending the game any
progress since you last saved it will be lost.
Be sure to "Save" the game prior to ending if
you have any progress you do not want to
lose.
To end the application click "End" from the
start menu, and then click "End Game" to
display a message asking if you want to
close the application.

Uninstalling the Game ▲TOP

About Uninstalling

Uninstalling will totally remove the A-Train 8 program data from your hard disk.
Perform an uninstall if you want to totally delete A-Train 8 from your computer.

* If you have changed the name of installed folders and files the uninstall
may not complete correctly.
* Data you have created during the game (save data etc.) will not be deleted
even if you perform an uninstall. After performing the uninstall you must
directly delete this data yourself if you want to remove it.

How To Uninstall... If You Must

① Open the "Control Panel" from the "Start" button.
② Open "Add or Remove Programs." (Called "Add / Remove Programs " in
Windows 2000.)



③ Select "A-Train 8" and click "Change / Delete."
④ Follow the onscreen directions to perform the uninstall.
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Forward ▲TOP

A-Train 8 is a simulation game which
combines the enjoyment of running a railway
company with the thrill of creating your own
city.
You will become the owner of a budding
railroad company, manage your trains and
develop subsidiary companies. Your
ultimate goal is to get your funds up to a
trillion.

Once you achieve the financial goal, you
will clear the map that you are playing.
However, you can continue to play on any
map even after clearing it, allowing you to
create your own ideal city. 
On the other hand, if your funds remain in the
red for too long the game will end. You must
therefore pay close attention to your funds.

Here the map "From the Mountains to the
Sea" will be used to explain basic game
controls.



Basic Controls ▲TOP

First, take a look at the game screen and basic controls.
Boot up "A-Train 8" and start the "From the Mountains to the Sea" map and a
game screen like that shown above will be displayed.

① Main Menu
Click to open the selected menu.

File : Start a new game, or save the game in progress.
Report : View information on your city and company.

Train : Perform train related commands, such as purchasing, placing,
removing and selling them.

Diagram : Use the Schedule Wizard to set up a schedule for stations and
points.

Rail : Lay or remove track.
Station : Build or remove stations, station concourses and material depots.
Construction : Build or remove other types of building.
Project : Plan for construction of a bullet train or maglev in your city.
Market : Buy or sell stocks, borrow money and sell subsidiary companies.
Option : Alter various game settings.
Help : Open the online manual and official site.

② Grip



Displays the current status of the camera. You can also drag the grip to move the
camera around.

③ Tool Bar
Click to turn each tool on and off.

Display satellite view.
Display grip.
Display a grid overlaid on the
map.
Display building information
on the cursor.
Point the camera to the north.
Remove all menus from the
window.
Open the height cut menu.
Open the train tracking menu.
Display the stop timer.

④ Satellite
Displays an overview of the entire map. Click anywhere on the satellite image to
move to that location.

⑤ Date, Time, Funds
Display the current date, time and funds.
You can also adjust the speed at which in-game time passes using the slider
above the time.

All controls other than entering text are performed by clicking menus or buttons.
Hold the left button and drag the game screen or satellite image to move it
around. Hold the right button and drag the game screen to change the direction of
the camera.

Running Your Railway Company ▲TOP

Facilities for Passenger Lines

The basics of running your company are "construct stations," "lay track" and
"place trains." Follow the steps below to learn the basic controls related to these



activities.

① First construct a station. Click "Station"
from the main menu.

② The Station menu will open. Click the
type of building you want to construct. For
now, select an "Elevated Station."

③ Click somewhere on the map to build an
elevated station. Now, in order to create a
track that will link to point A, this "Station-
001", you need to create a station to be
point B. Create another elevated station in a
position to link directly with the "Station-
001" platform 2.

④ Now you are set up to lay some track.
Lay track from point A, the initially placed
"Station-001", running toward point B.
Click "Track" from the main menu.

⑤ The Track menu will open. Click to
select the type of track to lay. Here use "flat
track."

⑥ Click somewhere on the map to
determine starting point for the track. Then
move the cursor and the intended track to be
laid will appear on the map. Then click
again on the ending point to actually lay the
track. Lay track to start from platform 2 of
point A "Station-001", and finish at the
point B elevated station.

⑦ Now the stations are connected by track.
The next step is to set up a train to run
between these two stations.

⑧ Click "Train" from the main menu.

⑨ The Train menu will open. The "Train



List" will open, from which you can manage
your trains. The boxes that are shown with a
train inside indicate trains that have already
been purchased.

⑩ Click a box that does not have a train
inside it and then click "Buy."

⑪ A list of the available trains will appear.
Select a regular "AR3" model and then click
the "Buy" button.

⑫ The AR3 has now been added to the
previously empty box. Click the box to
select it and then click on the track to place
it and start the train running.

A new train is now running through your city.
These basic controls will create the foundations of your company. Master them
so that you can lay exactly the track that you require.

Facilities for Freight Lines

Once people start to flow into your city the area around your stations will start to
develop. However, you can only construct new buildings if you have a supply of
the required "materials." Creating material factories and Freight stations will
secure a supply and further development of your city.

① Now try creating a Freight line linking
point A with point B in order to create a
supply of materials. First you need to create
a "Control Hub" close to point B, the
elevated station you previously built in the
"Facilities for Passenger Lines" section of
the tutorial. A Control Hub can be selected
and built from the Station menu, just like any
other station.

② Next extend track from the third platform
of point A, "Station-001", and connect it to



the Control Hub placed at point B.

③ Next buy a Freight train from the Train
menu. Purchase a "DC4" Freight train.

④ Place the purchased DC4 on the newly
created track.

⑤ Now you will need to create a
"Materials Depot" at point B in order to
store the materials carried there. You can
create a "Materials Depot (S)", "Materials
Depot (R)" or "Materials Depot (L)" from
the Station menu.

⑥ Move the cursor close to the control hub
placed at point B and click to place the
materials depot.

Now the factory at point A will also supply materials to point B, allowing
construction of buildings around both locations (As well as using material
factories already placed on the map you can build new ones from the
Construction menu).

As well as at control hubs it is also possible to load and unload Freight at rural
and elevated stations. However, using a control hub is cheaper than laying
Freight track through passenger stations.

City Development ▲TOP

Once you have secured both an influx of people and materials your city will
naturally start to develop. However, by tailoring the area around each station to
specific needs you can further boost population and help your city develop even
further.

① Create an office building around point A,
"Station-001." Click Construction from the
main menu.

② The Construction menu will open. Click



on "Office Building."

③ Click on "Building Name" to display the
types of buildings that you can build. Click
any office building you like, place the
cursor in the area of point A and click to
create the office building.

④ Follow the same basic steps to place a
"House" near point B, the elevated station
created in "Facilities for Passenger Lines."

This will create commuter traffic between the new office building and
residential area, leading to further city development.

Schedule Settings ▲TOP

After a train is placed it will run on a schedule of "stopping for an hour" at every
station. Trains will run under this setting, but will continue to do so even late at
night and other times when they are few passengers, meaning that line will soon
be in the red. Effective scheduling can reduce unnecessary running of trains and
bring down your costs.
Don't worry too much about setting up a complicated schedule to start with.
Begin by simply setting the start and end stations.

① Click on point B, the elevated station
created in "Facilities for Passenger Lines"
and a menu will open to set the schedule for
that station.

② Click on "Train List," "Action Mode"
and then "Start Time" and set the "Departure
Time" for the "AR3" placed during
"Facilities for Passenger Lines" to "08:00"
(or any time you wish).

③ In the same way, at point A "Station-
001", select "Action Mode" then "Departure
Time" for the "AR3" placed during
"Facilities for Passenger Lines" and set it to



17:00.

This sets the AR3 to "leaving the residential area at 8:00 in the morning, and
leaving the office district at 17:00 in the evening," a schedule perfect for
commuters. Putting together a schedule like this will reduce inefficient running of
the trains late at night and at other slow times.

Track Laying Techniques ▲TOP

Once your company begins to make money a "loop line" is a good way to
promote further development. A "loop line" is a circle of connected track. This
configuration allows you to run a number of trains at the same speed along a
single track without them getting backed up or interfering with each other.

Here, extend the track from point C, "Station-004" and point D, "Station-005" to
create a loop line. Simply placing track means that passengers can still only get
on or off the trains at "Station-004" and "Station-005," so you should also add 2
or 3 new stations.

You can also used elevated track, single
crosses and other track techniques in



addition to loop lines to increase the
complexity and coverage of your rail
network, running trains more effectively
than along single lines.

Some Final Advice ▲TOP

This covers the basic controls required to play "A-Train 8."
Use these controls well and your company should run smoothly and your profits
increase. However, the map still contains many undeveloped areas. Here are
some tips to take that money and put it back into further developing the city and
your company.

・Understand the Terrain
Maps also feature obstacles to city
development, such as mountains and rivers.
Before laying track and placing buildings
you'll need a firm grasp on exactly which
areas of the map are ripe for development.

・Understand Your City and Company
Status
The Report menu can be used at any time to
find out the status of your city and company.
Keeping a firm grasp on this information
will allow you to effectively develop your
city.

・Money Matters
If your funds remain in the red for too long
while playing "A-Train 8" the game will
end. Keep a close eye on your remaining
money.

Copyright 2008 ARTDINK. All Rights Reserved.



Game Modes

File <Back to Top
Page

Click "File" from the main menu and the File menu will open.
The File menu allows you to start a new game or load a game currently in
progress.

New Game
Registered Game
Load
Save
End

New Game ▲TOP

Click the "New Game" button and the "New Game" window will open.
From this window you can select one of the pre-registered maps to play from the
beginning.

A list of new game data will be displayed. Click the map you want to play and
then click the "Start New Game" button to begin.

Registered Game ▲TOP

Click the "Registered Game" button and the "Registered Game" window will
open.
From this window you can select a map that has been created in map creation
mode and registered as game data.

A list of registered game data will be displayed. Click the map you want to play
and then click the "Start Registered Game" button to begin.

Load ▲TOP

Click the "Load" button and the "Load" window will open.
From this window you can load previously saved game data.



A list of saved game data will be displayed. Click the data you want to play and
then click the "Start Saved Game" button to begin.

Save ▲TOP

Click the "Save" button and the "Save"
window will open.
From this window you can load
previously saved game data.

A list of boxes for save data will be
displayed. Click a box that does not
contain any data and then click the
"Save Game" button.

If you want to overwrite save data
select a box that already contains save
data by clicking on it and then click the
"Delete Saved Data" button. A message
will appear confirming that you want to
delete the data. Click "Yes" to
proceed.

A box containing save data

A box without save data

End ▲TOP

Click "End" and the "End" window will open.
From this window you can end the current game in progress and return to the
start menu.

Click the "End Without Saving" button. A message will appear confirming that
you want to end without saving the game. Click "Yes" to proceed.

* When you end the game current game progress will not be saved. If you
wish to save the game be sure to use the "Save" function prior to ending the
game.
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Report <Back to Top
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Select "Report" from the main menu to open the Report menu. 
The Report menu can be used to view information on your city and company.

City Data
Railway Company Data
Business Data
Balance Sheet

City Data ▲TOP

Click on the "City Data" button to switch the display to "City Data."
Here you can view information pertaining to your city.

City Name : The name of your city. Click and you can use the keyboard to
enter a name.

Outline : Displays "Village," "Town," "Small City," "Regular City" or
"Large City" depending on the scale of your city's development.

Type : Displays which industry is central to your city's development.
Population
Change : Displays the changes in population over the last 30 years.

Industries : Displays a chart showing the development and bias of your city's
industry.



Railway Company Data ▲TOP

Click the "Company Data" button to switch the display to "Company Data."
Here you can view information pertaining to your rail company.

Company
Name

: The name of your company. Click and you can use the keyboard to
enter a name.

Platforms : The total number of platforms on the map.
Points : The total number of points on the map.
Public
Crossing : The total number of public crossings on the map. 

Number of
Trains : The number of trains you have.

Tunnel : The total number of tunnels on the map.
Steel Bridge : The number of steel bridges on the map.

Total Length : The total length of track on the map, including tunnels and
bridges.

Roads : The total length of roads on the map.
Port : The total number of ports on the map.
Airport : The total number of airports on the map.
Bullet Train : The number of bullet train tracks brought to the city.
Maglev : The number of maglev tracks brought to the city.

Business Data ▲TOP



Click the "Business Data" button to switch the display to "Business Data."
Here you can view information pertaining to the profits of your company and its
subsidiaries.

Capital : Current capital and capital changes in the last 30 days.
Railway
Profit / Day : Today's rail profits and changes in profits over the last 30 days.

Subsidiary
Profit / Day

: Today's subsidiary profits and changes in those profits over the
last 30 days.

Subsidiary
Profit /
Year

: The total profits from all subsidiaries since the 1st of January this
year, and the profits of each individual subsidiary.

Balance Sheet ▲TOP



Click the "Balance Sheet" button to switch the display to "Balance Sheet."
Here you can view an overall report of your company's finances for the current
year, starting from 1st of January.

Total
Returns ：

A list of all profits, including those from your railway, ports and
airports, selling of stock, subsidiary companies and interest
from stocks, and then the total.

Total Costs ：

A list of all expenses, including those incurred by your railway,
ports and airports, selling of stock, subsidiary companies,
public facilities such as schools and parks, the charges for
purchasing stock and interest paid on loans, and then the total.

Total Debt ：
A list of all debts, including money borrowed from the bank and
income tax, property tax and VAT to be paid at the next tax date,
and then the total.

Tax
Period
End Date

ayment
Date Tax Rate

Income
Tax

Period
ends 31st
December
each year

Paid on
1st April
following
year

10% of profits

Property
Tax

Period
ends 31st
December
each year

Paid on
1st May
following
year

5% of all capital aside
from funds



VAT
At the end
of each
month

Paid on
1st
following
month

5% of all returns aside
from stock sales

Total
Capital ：

The total appraised worth of your capital, track, stations and
other rail facilities, appraised worth of all of your trains and
appraised worth of all the ports, airports, subsidiaries and
stocks, and then the total.

Total Funds ：
The total of your funds plus profits carried over from the
previous year. Funds in this game also refers to the money that
you begin a new game with.

Returns
Shift / Year ： The change in returns over 30 years.

Expenses
Shift / Year ： The change in expenses over 30 years.

Profits Shift
/ Year ： The change in profits over 30 years.
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Game Modes

Train <Back to Top
Page

Select "Train" from the main menu and the Train menu will open.
From the Train menu you can perform all operations related to trains, such as
buying, placing, removing and selling them.

* The train data included in the game is fictional, and may differ from actual
trains.

Train List
Actions from the Train List
   ・Buy Trains
   ・Place Trains
   ・Remove Trains
   ・Sell Trains

Train List ▲TOP

On the Train menu the "Train List" will be displayed, showing the status of all
registered trains.
You can purchase or place trains from this list. You can register up to 40 trains
at once.

* You can choose to set the number of registered trains allowed
simultaneously to 60 from the Options menu.

This box is yet to be filled with a
purchased and registered train.
You can purchase a train from
here.
This train has been purchased but
has not been placed on the map
yet. You can place or sell this
train.
This train has been placed on the
map. You can remove the train or
reverse it.

* The ● mark displayed by a placed



train indicates : ● : in Transit, ● :
Slowing Down, ● : Stopped

Actions from the Train List ▲TOP

Buy Trains

Click a box with no train registered to it and then click the "Buy Train" button to
display a list of trains that can be purchased. Then click the train from here that
you want to purchase and click the "Confirm Sale" button to buy the train.

* You can only buy super express trains if you have set up a bullet train or
maglev from the Project menu.

Type The type of train, such as commuter
or rapid express

Mode Name The model name of the train
Cruising
Speed

The speed the train will travel on
the map

Train
Configuration

The number of carriages in the
train. Click to change.

Capacity The train's capacity (Maximum
Load for Freight trains).

Passenger
Load (%)

The train's maximum passenger
load (Cargo Load (%) for Freight
trains).



Purchase
Price The cost to buy the train.

Trains are also broadly divided into passenger and Freight types.
Passenger trains carry people, while Freight trains carry materials.

Passenger
Trains

Commuter Passenger Load :
200%

High Speed
Commuter

Passenger Load :
180%

Passenger Passenger Load :
160%

Express Passenger Load :
140%

Limited
Express

Passenger Load :
120%

Express Passenger Load :
110%

Underground Passenger Load :
200%

Freight
Trains

Freight
Train Cargo Load : 100%

Express
Freight Cargo Load : 100%

Place Trains

Click a train not yet placed to select it and then
click a section of straight track longer than the
number of carriages the train has or a station to
place the train.
When placing a train click on the height bar at
the side of the train image to align it with the
height of the track.

The following data is displayed for a placed
train.

The type of train, such as



Type commuter or rapid express
Mode Name The model name of the train
Train
Configuration

The number of carriages the
train has.

Capacity The train's capacity (Maximum
Load for Freight trains).

Number of
Passengers

The current number of
passengers on the train (Cargo
for Freight Trains).

Profits / Day Today's total profits from the
selected train.

Costs / Day Today's total costs for the
selected train.

Remove Trains

Click a train already placed and then click the "Remove Train" button to remove
it from the map.

Sell Trains

Select a train that is not currently placed on the map and click the "Sell Train"
button to sell the train.
Trains are sold at 60% of their purchase price.
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Select "Diagram" from the main menu to open the Schedule menu.
The Schedule menu allows you to use the Schedule Wizard to create a schedule
for your trains according to the routes they currently take.

Schedule Menu
Stn. Settings / Points Settings
   ・Stn. Settings
   ・Points Settings

Schedule Menu ▲TOP

A menu for opening the Schedule
Wizard.
Click to select the train you wish to use
the Wizard with from the menu and then
click the "Start Wizard Settings" to start
the Schedule Wizard.

When finishing with the Schedule
Wizard be sure to click the "Apply
Wizard Settings" button.

* If you turn on "Restore Time on
Schedule Wizard" from the Options
menu you will be able to abort the
Wizard as it is running, as well as
having the choice to reset the times
to prior to using the Wizard rather
than simply applying the results once
it finishes.

Stn. Settings / Points Settings ▲TOP

Stn. Settings



When a train running the Schedule Wizard reaches a station you can choose from
the following options.

One Hour
Stop ：Depart one hour after stopping in the station.

Pass
Through ：Don't stop in the station.

Passage ：Depart after train coming from the other direction clears the
station, (including pass throughs).

Wait for
Overtake ：Depart after a train coming from the same direction clears the

station, (including pass throughs.)
Wait for
Arrival ：Depart after the next train arrives in the station (not including

pass throughs).
Departure
Time ：Use this setting to indicate a specific departure time.

Depart on
00:00 Set the time for the first train of the day.

00:00
Interval Set the interval between trains departing the station.

Daily Select the days to apply these settings to.
Monthly Select the months to apply these settings to.

Stop ： The train will not leave the station after arriving.

Straight ： The train will continue in the direction it entered the station in.

Reverse ： The train will reverse and travel back in the direction it came



from.
Do Nothing ：Do not load or unload cargo.

Load ：
If the freight train has space and there is an available factory or
materials depot within range then materials will be loaded onto
the train.

Unload ：
If the freight train has space and there is an available factory or
materials depot within range then materials will be unloaded
from the train.

Load &
Unload ：

If the conditions for loading are met materials will be loaded,
and if the conditions for unloading are met materials will be
unloaded.

* If you turn on "Set Station Settings By Platform" on the Options menu
you can create a different schedule for each platform.
* If you turn on "Minimize Units of Time on Schedule" on the Options menu
you can set the schedule times down to the minute.

Points Settings

When a train running the Schedule Wizard reaches points you can choose from
the following options.

Straight ： The train will pass straight over the points when it reaches them.
Branch ： The train will branch off from the points when it reaches them.

00:00 -
23:59 Specify the time the train will proceed down the branch track.



* Branch settings can only be set when "Set Branch Time in Point Settings"
under Options is turned on.
* If you turn on "Minimize Units of Time on Schedule" on the Options menu
you can set the branch schedule time down to the minute. 
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Select "Rail" from the main menu to open the Track menu.
You can lay and remove track from the Track menu.

Laying Mode
   ・Flat Track (Straight / Curved)
   ・Flat Track (Points)
   ・Flat Track (Tunnel)
   ・Gradated Track
Removal Mode

Laying Mode ▲TOP

Flat Track (Straight / Curved)

Click the "Laying Mode" button and then click "Flat Track" to start laying flat
track.
"Flat Track" allows you to lay straight or curved track across terrain of a
uniform height.

Click the point you want to start laying track from and then try moving the cursor.
You'll see yellow track (laying guide) leading from the starting point to the
cursor. Click again and the displayed track will be laid. (The track will be
displayed in red over locations in which it cannot be laid.)
If you want to lay elevated or underground track use height cut or the height bar
next to the track image to select the height before laying.

* You can right click to cancel the laying guide.



Flat Track (Points)

With construction of flat track turned on
click on already laid track and a temporary
point will be created in yellow on the track.
Click the same spot again to cycle through
the point types.
Once you have selected the type of point you
want to place move the cursor to extend the
track and then click to place the point and
connecting track. (The point will be
displayed in red over locations in which it
cannot be placed.)

There are numerous different types of point,
each of which should be used depending
upon circumstances. At a crossing, unlike
points, the track does not branch. (A cross-
shaped crossing allows two flat tracks to
cross each other.)

Points Left Curve (Turn
Out) Siding Single Crossing

Double Crossing Crossing Crossing (Cross-Shape)



Flat Track (Tunnel)

If you lay track toward a mountain a tunnel
will automatically be placed. However,
there are limitations on the places in which a
tunnel entrance can be placed - the mountain
face must be at a 45 degree angle to the
ground. (The tunnel will be displayed in red
over locations in which it cannot be placed.)

Gradated Track

Click "Laying Mode" and then select
"Gradated Track" to lay gradated track.
"Gradated Track" can be used to lay track at
varying heights.

Right click to decide facing, and then move
the cursor to the desired location and click to
place the gradated track. (The track will be
displayed in red over locations in which it
cannot be placed.)
You can also use the height cut or height bar
next to the track image to freely adjust the
height of gradated track. This allows
sections of elevated track to be linked
together, or underground tracks to be linked
with those on the surface.

Removal Mode ▲TOP

Click "Removal Mode" to enable removal of
track.

Place the cursor over the area you want to
remove and click to remove the track.

* If you select "Turn On Removal Via
Area Select" from the Options menu you



can select an entire area from which to
remove all track. Area select is performed
by clicking the start and end points of the
removal area.
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Select "Station" from the main menu to open the Station menu.
From the Station menu you can build and remove stations, station concourses and
material depots.

Construction Mode
   ・Station
   ・Station Concourse
   ・Material Depot
Removal Mode

Construction Mode ▲TOP

Station

Click "Construction Mode" and then click one
from "Rural Station," "Elevated Station,"
"Underground Station" and "Control Hub" to
build a station.
At stations, people can board or disembark,
and freight can be loaded or unloaded from
trains.

Click to select "Station Size" and "Number of
Platforms," right click to select station facing,
move the cursor to the location in which you
wish to build the station and click to start
construction.
The height of elevated and underground
stations can also be adjusted using the height
bar next to the image of the station (The station
will be displayed red in locations in which it
cannot be built).

Rural
Station

The area around a rural station
will develop more slowly than
that of other station types.



Elevated
Station

The area around an elevated
station will develop more
quickly than that of other station
types. This type of station can
also be built on high ground.

Underground
Station

Can only be built underground.
Underground stations will
facilitate above-ground
development.

Control Hub

A station at which materials
can be loaded or unloaded.
Even if you have passenger
trains stop here they will
generate no profits for you.

Station Concourse

Click "Construction Mode" and then click
"Station Concourse 1" or "Station Concourse
2" to create a concourse in front of a station.
A station concourse will facilitate
development around the attached station.

Right click to select concourse facing and
then move the cursor to the location in which
you wish to build it and click to start
construction (The concourse will be
displayed red in locations in which it cannot
be built).

Material Depot 

Click "Construction Mode" and then click
"Materials Depot (S)," "Materials Depot
(R)" or "Materials Depot (L)" to create a
materials depot.
Materials depots can be used to store
materials.

Right click to select materials depot facing



and then move the cursor to the location in
which you wish to build it and click to start
construction. If you line the height cut up
with underground you can build material
depots underground anywhere aside from
beneath mountains. (The concourse will be
displayed red in locations in which it cannot
be built.)

Removal Mode ▲TOP

Click "Removal Mode" to activate removal of buildings.

Place the cursor over the building you wish to remove and click to remove it.
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Select "Construction" from the main menu to open the Construction menu.
The Construction menu allows you to build and remove buildings from the map.

Construction Mode
Removal Mode

Construction Mode ▲TOP

Click "Construction Mode" to active creation of buildings.

Click "Type of Building" and "Building Name" to select them, right click to
decide the facing of the building, then move the cursor to the location in which
you wish to perform the construction and click to begin the work (The building
will be displayed red in locations where it cannot be built).

* Types of buildings can also be cycled through by clicking on the building
view.

Materials
Factory ：Can create building materials.

Public Facility ： Includes schools and parks. As these are public facilities they
will not make any profit for you.

Shop ：Mainly includes buildings that increase commerce values.
Hotel ：Mainly includes buildings that increase commerce values.



House ：Mainly includes buildings that increase population.Office
Building ：Mainly includes buildings that increase business values.

High Rise
Building ：

Mainly includes buildings that increase business values.
It will take a number of weeks to complete construction of a
high rise building.

Super High
Rise Building ：

Mainly includes buildings that increase business values.
It will take a number of weeks to complete construction of a
super high rise building.

Entertainment
Facility ：Mainly includes buildings that increase leisure and culture

values. 

Sports Facility ：Mainly includes buildings that increase leisure and culture
values. 

Landmark ： Includes buildings that add character to your map.
Super
Structure ： Includes airports and ports.

Removal Mode ▲TOP

Click "Removal Mode" to activate removal of buildings.

Place the cursor over the building you wish to remove and click to remove it.
You can only remove buildings that you can also build from the Construction
menu.

* If you select "Turn On Removal Via Area Select" from the Options menu
you can select an entire area from which to remove all buildings. Area select
is performed by clicking the start and end points of the removal area.

If you choose to build a new building on top of an existing one removal ⇒
construction will automatically be performed. This cannot be performed on top
of a Public Facility. If you wish to remove a Public Facility you must do so
manually.

Construction Cost
(Remove) Land Usage Cost

Construct Own Company
Building on Vacant Land Construction Cost Land Purchase Cost

Remove Own Company
Building Removal Cost Land Sale Value

Build Own Company



Building on Company
Land

Construction Cost Removal Cost

Remove Other Property Removal Cost Land Purchase Cost －
Land Sale Value

Build Own Company
Building on Other
Company Land

Construction Cost Removal Cost＋Land
Purchase Value

* Construction cost is 20% of the building's value.
* Land sale value is 60% of land purchase cost.
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Select "Project" from the main menu to open the Project menu.
You can use the Project menu to bring a bullet train or maglev to your city.

Bullet Train Mode
Maglev Mode

Bullet Train Mode ▲TOP

Click "Bullet Train Mode" and you can initiate a plan to bring a bullet train to
your city.

Click the "Change Direction" button to select a direction in which to build the
track, then move the cursor and click to decide the position of the track. The
number of days required for the construction and the budget will be displayed.
Confirm the details and then click "Approve This Plan" to begin the construction.

* Bullet train track can only be laid in a straight line across the map.
* If the track is displayed in red then it indicates that the special elevated
track cannot be built in that area, due to mountains or other obstacles.
* A massive amount of money is needed to bring a bullet train to your city.
* The construction of the special elevated track required by a bullet train
takes top construction priority, meaning that any buildings in the way of the



intended track construction will be removed.
* The special elevated track required by the bullet train cannot be removed
once it has been placed. Consider its placement very carefully.
* Once bullet train construction begins the project cannot be aborted.
* Bullet train track is special elevated track at level 5 height.
* It is not possible to run trains purchased from the Train menu on the
special bullet train track.
* After bringing bullet train track to your city you will be able to purchase
bullet trains from the Train menu.

Maglev Mode ▲TOP

Click "Maglev Mode" and you can initiate a plan to bring a maglev to your city.

Click the "Change Direction" button to select a direction in which to build the
track, then move the cursor and click to decide the position of the track. The
number of days required for the construction and the budget will be displayed.
Confirm the details and then click "Approve This Plan" to begin the construction.

* Maglev track can only be laid in a straight line across the map.
* If the track is displayed in red then it indicates that the special elevated
track cannot be built in that area, due to mountains or other obstacles.
* A massive amount of money is needed to bring a maglev to your city.
* The construction of the special elevated track required by a maglev takes
top construction priority, meaning that any buildings in the way of the
intended track construction will be removed.
* The special elevated track required by the maglev cannot be removed



once it has been placed. Consider its placement very carefully.
* Once maglev construction begins the project cannot be aborted.
* Maglev track is special elevated track at level 6 height.
* It is not possible to run trains purchased from the Train menu on the
special Maglev track.
* After bringing Maglev track to your city you will be able to purchase
maglev trains from the Train menu.

Copyright 2008 ARTDINK. All Rights Reserved.



Game Modes

Market <Back to Top
Page

Select "Market" from the main menu and the Market menu will open,
From this menu you can buy and sell stock, take out a loan or sell off subsidiary
companies.

Share Exchange
Bank
Real Estate Sale

Share Exchange ▲TOP

Click on the "Share Exchange" button to display the share exchange screen.
Here you can buy and sell stocks.

Click on the "Buy Stocks" button to buy stock, and the "Sell Stocks" button to sell
stock.
Click to select the name of the stock you wish to trade then click on the "Shares
to Purchase" or "Shares to Sell" to select the number of stock to deal in.
Then click on the "Purchase Stock" or "Sell Stock" buttons to purchase or sell the
indicated number of stock.

* Company names, details of their business and stock prices are fictitious
and totally unrelated to any real companies or stock.



Bank ▲TOP

Click on "Bank" to display the bank screen.
From here you can take out a loan.

Click to select "One Year Loan" or "Two
Year Loan" and then click "Loan Amount" and
enter the amount you want to borrow.
Then click the "Take Out Loan" button to
borrow the indicated amount.

* The maximum amount you can borrow is
60% of your current total capital minus any
other current loans.
* The loan amount will be taken
automatically from your capital on the
repayment date.
* Click on the loan list and click the
"Repay Loan" button to immediately pay
back the corresponding loan.

Real Estate Sale ▲TOP

Click on "Real Estate Sale" to display the
real estate screen.
From here you can sell buildings belonging
to your company.

Click on the type and name of the building
you want to see and then click on "Sell
Property" to sell buildings that belong to
your company.
You can also click on "Jump to Property
Location" to jump the screen to the location
of that property.
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Select "Option" from the main menu and the Option menu will open.
From the Options menu you can change various options relating to game display
and settings.

Side Menu
   ・Satellite Display
   ・Display Grip
   ・Display Target Information
   ・Display Height Cut Bar
   ・Tracking Device
   ・Timer
Map Display
   ・Display Water Surface
   ・Grid
   ・Image Clipping Settings
   ・LOD
Weather
   ・Time-Based Palette Changes
   ・Display Weather
Time
   ・Time Stops When Window Opens
   ・Pause Prior To Event Occurring
   ・Pause Before Final Accounts (1st Jan)
   ・Boost Maximum Passage of Time Speed
Schedule
   ・Set Station Settings by Platform
   ・Set Branch Time in Points Settings
   ・Display Simple Schedule
   ・Display Train Numbers
   ・Mark Point Branches
   ・Restore Time on Schedule Wizard
   ・Display Time on Schedule Wizard
   ・Minimize Units of Time on Schedule
   ・Expand Maximum Number of Trains
Data Display
   ・Attach Description to Name of Stocks
   ・Attach Description to Train
   ・Colour Company Buildings



   ・Limit Subsidiary List to Within Screen
   ・Sort Train Purchases in Descending Order
   ・Select Language
Area Select
   ・Turn On Removal Via Area Select
System
   ・Sound
   ・HDTV Safe Area

Side Menu ▲TOP

Satellite Display

Turn display of the satellite image on or off.

・Increase Transparency
Increase the transparency of the displayed satellite image.
This option can only be clicked and altered when "Satellite Display" is turned
on.

・Auto Refresh Display
The satellite image will automatically refresh.
This option can only be clicked and altered when "Satellite Display" is turned
on.

Display Grip

Turn display of the grip on or off.
The grip allows more precise control of the camera.

・Frame Rate
From the data displayed on the grip, the data indicating horizontal rotation will
be replaced with display of frame rate.
This option can only be clicked and altered when "Grip Display" is turned on.

Display Target Information

Turn display of target information on or off.



・Display Target Name
The name of a building beneath the cursor will be displayed.
This option can only be clicked and altered when "Display Target Information"
is turned on.

・Display Target Data
The data of a building beneath the cursor will be displayed.
This option can only be clicked and altered when "Display Target Information"
is turned on.

Height Cut Bar

Turn display of the height cut bar on or off.
Height cut functions can only be used when the height cut bar display is turned
on.

Tracking Device

Turn display of a menu allowing control of the tracking device on or off.
Tracking device functions can only be used when the menu allowing control of
the tracking device is turned on.

Timer

Turn display of the stop timer on or off.

Map Display ▲TOP

Display Water Surface

Turn display of the water surfaces on or off.

Grid

Turn grid display over the map on or off.



Image Clipping Settings

Set the maximum distance at which buildings will be displayed.
Buildings beyond the set distance will not be displayed.

* This setting also affects limits placed on zooming the camera.

・Clipping (Close Scenery)
Only buildings in the direct vicinity will be displayed. This setting displays the
least number of buildings.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

・Clipping (Intermediate Scenery)
Buildings within an intermediate range will be displayed.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

・Clipping (Distant Scenery)
Buildings will be displayed a considerable way into the distance.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

・Clipping (Horizon Scenery)
Buildings will be displayed even further away than on the "Distant" setting. This
setting displays the most number of buildings.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

LOD



Turn simplified display of distant buildings on or off.
With this option turned on distant buildings will be displayed in a simplified
form, helping to improve frame rate.

Weather ▲TOP

Time-Based Palette Changes

Turn palette changes due to time and seasons on or off.
If turned off, the current state at that time will be maintained.

Display Weather

Turn display of the weather on or off.
If turned off the weather will remain clear at all times.

・Display Rain
Turn display of rain on or off.
This option can only be clicked and altered when "Display Weather" is turned
on.

・Display Snow
Turn display of snow on or off.
This option can only be clicked and altered when "Display Weather" is turned
on.

Time ▲TOP

Time Stops When Window Opens

Turn in-game time stopping when the main menu is opened on or off.
However, even when turned off opening the File menu or Schedule menu will
stop in-game time.

Pause Prior To Event Occurring

Turn automatic event pausing on or off.



Events include "attaining a capital goal" and "game over."

Pause Before Final Accounts (1st Jan)

Enable/disable the game automatically pausing at 0:00 on 1st January game time.
The final accounts for the year are performed at the end of 31st December each
game year.

Boost Maximum Passage of Time Speed

Increase the passage of time beyond even that possible using the slide bar
displayed above the time in-game.
However, the frame rate will fall with this setting turned on.

Schedule ▲TOP

Set Station Settings by Platform

Enable/disable setting individual schedules for each platform in a station.

Set Branch Time in Points Settings

Enable/disable the ability to set a time for the train to depart from a point after
selecting "Branch" in point settings.

Display Simple Schedule

Turn a simple schedule display for stations on or off.

Display Train Numbers

Turn display of train numbers on or off.

・Display Running Time
Display the running time for the train since it left its last station.



This option can only be clicked and altered when "Display Running Time" is
turned on.

Mark Point Branches

Turn display of branch marks on or off in point settings.

・Display Everything
All branches will be marked in point settings.
This option can only be clicked and altered when "Mark Point Branches" is
turned on.

Restore Time on Schedule Wizard

Enable/disable the ability to restore time on the Schedule Wizard.
When turned on you will be able to "not apply the Wizard changes and return
time to the point the wizard was opened" and "apply the Wizard changes and
return time to the point the wizard was opened" after using the Schedule Wizard.

Display Time on Schedule Wizard

Turn passed-through stations display on or off during the Schedule Wizard.

Minimize Units of Time on Schedule

Enable/disable the ability to stipulate time down to the minute on "Departure
Time," "Point Settings," "Branch" etc.

Expand Maximum Number of Trains

Select from being able to use 40 or 60 trains at once.
Trains numbered 41 - 60 acquired with this turned on cannot be removed or sold
if the option is then turned off.
If this option is then turned back on, the trains can be controlled again as normal.

Data Display ▲TOP



Attach Description to Name of Stocks

Enable/disable the option to attach a description to the name of stocks in the
Market menu.

Attach Description to Train

Enable/disable the option to attach a description to a train in the Train menu.

Colour Company Buildings

Enable/disable the colouring of buildings belonging to your company.

Limit Subsidiary List to Within Screen

Enable/disable limiting the subsidiary companies displayed during a property
sale in the Market menu to those currently displayed on the screen.

Sort Train Purchases in Descending Order

Select ascending or descending order when making a train purchase from the
Train menu.

Select Language

You can choose the game text language from English, French, Italian, German
and Spanish.

Area Select ▲TOP

Turn On Construction Via Area Select

Allow entire areas of track and buildings, from the Track and Construction
menus respectively, to be selected and removed at once.



System ▲TOP

Sound

Turn in-game sound on or off.

・Music
Turn music on or off.
This option can only be clicked and altered when "Sound" is turned on.

・SE
Turn sound effects on or off.
This option can only be clicked and altered when "Sound" is turned on.

HDTV Safe Area

Enable/disable menu displays in the centre of the screen.
Use this if, when outputting your PC to your TV the menu sticks off the edge of
the screen.
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Select "Help" from the main menu to open the Help menu.
From here you can open the online manual and the official site.

Manual
Home Page
Version Information

Manual ▲TOP

Open the "A-Train 8" online manual (this manual.)

Home Page ▲TOP

Open the "Degica Co., Ltd." Official Home Page.

Version Information ▲TOP

Check the version information for your copy of "A-Train 8."
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Click "File" from the main menu and the File menu will open.
The File menu allows you to start a new game or load a game currently in
progress.

Create New
Revise Registered Game
Register New Game
Load Map In Progress
Save Map In Progress
End

Create New ▲TOP

Click the "Create New" button and the "Create New" window will open.
This window will call up a flat map at height 2.

Click the "Start Creating New" button to proceed.

Revise Registered Game ▲TOP

Click the "Revise Registered Game" button and the "Revise Registered Game"
window will open.
From this window you can use Map Construction to revise a map previously
created and registered.

A list of registered game data will be displayed. Click to select the map you
want to play and then click the "Revise Registered Game" button.

Register New Game ▲TOP



Click the "Register New Game" button to open the "Register New Game"
window.
From this window you can register the map currently being edited as a new
game, allowing it to be played in the normal Game Mode.

Click each category to input text. Once you have created the required data click
the "Register New Game" button.

・Game Name : Enter a name for the game.
・City Name : Enter a name for the city.
・Company Name : Enter a name for the
railway company
・Game Description : Enter a description to
be displayed upon selecting the new game
・Funds Settings : Select the amount of
available funds at the start of the game
・Start Date Settings : Select the date at the
start of the game
・Start Weather Settings : Select the
weather at the start of the game

Load Map In Progress ▲TOP

Click the "Load Map In Progress" button to open the "Load Map In Progress"
window.
From this window you can save the map currently being edited (You can
continue to edit the map after making the save).

A list of saved map data will be displayed. Click to select the map you want to
play and then click the "Load Saved Map In Progress" button.

Save Map In Progress ▲TOP



Click the "Save Map In Progress"
button to open the "Save Map In
Progress" window.
From this window you can save the
map currently being edited. (You can
continue to edit the map after making
the save.)

A list of boxes for save data will be
displayed. Click a box that does not
contain any data and then click the
"Save Map In Progress" button.

If you want to overwrite save data
select a box that already contains save
data by clicking on it and then click the
"Delete Saved Map In Progress"
button. A message will appear
confirming that you want to delete the
data. Click "Yes" to proceed.

A box containing save data

A box without save data

End ▲TOP

Click "End" and the "End" window will open.
From this window you can end the map currently being edited and return to the
start menu.

Click the "End Without Saving" button. A message will appear confirming that
you want to end without saving the game. Click "Yes" to proceed.

* When you end the map any progress will not be saved. If you wish to save
any changes to the map be sure to use the "Save" function prior to ending
your editing.
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Select "Report" from the main menu to open the Report menu. 
The Report menu can be used to view information on your city and company.

City Data
Railway Company Data
Business Data
Balance Sheet

City Data ▲TOP

Click on the "City Data" button to switch the display to "City Data."
Here you can view information pertaining to your city.

City Name : The name of your city. Click and you can use the keyboard to
enter a name.

Outline : Displays "Village," "Town," "Small City," "Regular City" or
"Large City" depending on the scale of your city's development.

Type : Displays which industry is central to your city's development.
Population
Change : Displays the changes in population over the last 30 years.

Industries : Displays a chart showing the development and bias of your city's
industry.



Railway Company Data ▲TOP

Click the "Company Data" button to switch the display to "Company Data."
Here you can view information pertaining to your rail company.

Company
Name

: The name of your company. Click and you can use the keyboard to
enter a name.

Platforms : The total number of platforms on the map.
Points : The total number of points on the map.
Public
Crossing : The total number of public crossings on the map. 

Number of
Trains : The number of trains you have.

Tunnel : The total number of tunnels on the map.
Steel Bridge : The number of steel bridges on the map.

Total Length : The total length of track on the map, including tunnels and
bridges.

Roads : The total length of roads on the map.
Port : The total number of ports on the map.
Airport : The total number of airports on the map.
Bullet Train : The number of bullet train tracks brought to the city.
Maglev : The number of maglev tracks brought to the city.

Business Data ▲TOP



Click the "Business Data" button to switch the display to "Business Data."
Here you can view information pertaining to the profits of your company and its
subsidiaries.

Capital : Current capital and capital changes in the last 30 days.
Railway
Profit / Day : Today's rail profits and changes in profits over the last 30 days.

Subsidiary
Profit / Day

: Today's subsidiary profits and changes in those profits over the
last 30 days.

Subsidiary
Profit /
Year

: The total profits from all subsidiaries since the 1st of January this
year, and the profits of each individual subsidiary.

Balance Sheet ▲TOP



Click the "Balance Sheet" button to switch the display to "Balance Sheet."
Here you can view an overall report of your company's finances for the current
year, starting from 1st of January.

Total
Returns ：

A list of all profits, including those from your railway, ports and
airports, selling of stock, subsidiary companies and interest
from stocks, and then the total.

Total Costs ：

A list of all expenses, including those incurred by your railway,
ports and airports, selling of stock, subsidiary companies,
public facilities such as schools and parks, the charges for
purchasing stock and interest paid on loans, and then the total.

Total Debt ：
A list of all debts, including money borrowed from the bank and
income tax, property tax and VAT to be paid at the next tax date,
and then the total.

Tax
Period
End Date

Payment
Date Tax Rate

Income
Tax

Period
ends 31st
December
each year

Paid on
1st April
following
year

10% of profits

Property
Tax

Period
ends 31st
December
each year

Paid on
1st May
following
year

5% of all capital aside
from funds



VAT
At the end
of each
month

Paid on
1st
following
month

5% of all returns aside
from stock sales

Total
Capital ：

The total appraised worth of your capital, track, stations and
other rail facilities, appraised worth of all of your trains and
appraised worth of all the ports, airports, subsidiaries and
stocks, and then the total.

Total Funds ：
The total of your funds plus profits carried over from the
previous year. Funds in this game also refers to the money that
you begin a new game with.

Returns
Shift / Year ： The change in returns over 30 years.

Expenses
Shift / Year ： The change in expenses over 30 years.

Profits Shift
/ Year ： The change in profits over 30 years.
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Select "Train" from the main menu and the Train menu will open.
From the Train menu you can perform all operations related to trains, such as
buying, placing, removing and selling them.

* The train data included in the game is fictional, and may differ from actual
trains.

Train List
Actions from the Train List
   ・Buy Trains
   ・Place Trains
   ・Remove Trains
   ・Sell Trains

Train List ▲TOP

On the Train menu the "Train List" will be displayed, showing the status of all
registered trains.
You can purchase or place trains from this list. You can register up to 40 trains
at once.

* You can choose to set the number of registered trains allowed
simultaneously to 60 from the Options menu.

This box is yet to be filled with a
purchased and registered train.
You can purchase a train from
here.
This train has been purchased but
has not been placed on the map
yet. You can place or sell this
train.
This train has been placed on the
map. You can remove the train or
reverse it.

* The ● mark displayed by a placed



train indicates : ● : in Transit, ● :
Slowing Down, ● : Stopped

Actions from the Train List ▲TOP

Buy Trains

Click a box with no train registered to it and then click the "Buy Train" button to
display a list of trains that can be purchased. Then click the train from here that
you want to purchase and click the "Confirm Sale" button to buy the train.

* You can only buy super express trains if you have set up a bullet train or
maglev from the Project menu.

Type The type of train, such as commuter
or rapid express

Mode Name The model name of the train
Cruising
Speed

The speed the train will travel on
the map

Train
Configuration

The number of carriages in the
train. Click to change.

Capacity The train's capacity (Maximum
Load for Freight trains).

Passenger
Load (%)

The train's maximum passenger
load (Cargo Load (%) for Freight
trains).



Purchase
Price The cost to buy the train.

Trains are also broadly divided into passenger and Freight types.
Passenger trains carry people, while Freight trains carry materials.

Passenger
Trains

Commuter Passenger Load :
200%

High Speed
Commuter

Passenger Load :
180%

Passenger Passenger Load :
160%

Express Passenger Load :
140%

Limited
Express

Passenger Load :
120%

Express Passenger Load :
110%

Underground Passenger Load :
200%

Freight
Trains

Freight
Train Cargo Load : 100%

Express
Freight Cargo Load : 100%

Place Trains

Click a train not yet placed to select it and then
click a section of straight track longer than the
number of carriages the train has or a station to
place the train.
When placing a train click on the height bar at
the side of the train image to align it with the
height of the track.

The following data is displayed for a placed
train.

The type of train, such as



Type commuter or rapid express
Mode Name The model name of the train
Train
Configuration

The number of carriages the
train has.

Capacity The train's capacity (Maximum
Load for Freight trains).

Number of
Passengers

The current number of
passengers on the train (Cargo
for Freight Trains).

Profits / Day Today's total profits from the
selected train.

Costs / Day Today's total costs for the
selected train.

Remove Trains

Click a train already placed and then click the "Remove Train" button to remove
it from the map.

Sell Trains

Select a train that is not currently placed on the map and click the "Sell Train"
button to sell the train.
Trains are sold at 60% of their purchase price.
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Select "Diagram" from the main menu to open the Schedule menu.
The Schedule menu allows you to use the Schedule Wizard to create a schedule
for your trains according to the routes they currently take.

Schedule Menu
Stn. Settings / Points Settings
   ・Stn. Settings
   ・Points Settings

Schedule Menu ▲TOP

A menu for opening the Schedule
Wizard.
Click to select the train you wish to use
the Wizard with from the menu and then
click the "Start Wizard Settings" to start
the Schedule Wizard.

When finishing with the Schedule
Wizard be sure to click the "Apply
Wizard Settings" button.

* If you turn on "Restore Time on
Schedule Wizard" from the Options
menu you will be able to abort the
Wizard as it is running, as well as
having the choice to reset the times
to prior to using the Wizard rather
than simply applying the results once
it finishes.

Stn. Settings / Points Settings ▲TOP

Stn. Settings



When a train running the Schedule Wizard reaches a station you can choose from
the following options.

One Hour
Stop ：Depart one hour after stopping in the station.

Pass
Through ：Don't stop in the station

Passage ：Depart after train coming from the other direction clears the
station, (including pass throughs).

Wait for
Overtake ：Depart after a train coming from the same direction clears the

station, (including pass throughs.)
Wait for
Arrival ：Depart after the next train arrives in the station (not including

pass throughs).
Departure
Time ：Use this setting to indicate a specific departure time.

Depart on
00:00 Set the time for the first train of the day.

00:00
Interval Set the interval between trains departing the station.

Daily Select the days to apply these settings to.
Monthly Select the months to apply these settings to.

Stop ： The train will not leave the station after arriving.

Straight ： The train will continue in the direction it entered the station in.

Reverse ： The train will reverse and travel back in the direction it came



from.
Do Nothing ：Do not load or unload cargo.

Load ：
If the freight train has space and there is an available factory or
materials depot within range then materials will be loaded onto
the train.

Unload ：
If the freight train has space and there is an available factory or
materials depot within range then materials will be unloaded
from the train.

Load &
Unload ：

If the conditions for loading are met materials will be loaded,
and if the conditions for unloading are met materials will be
unloaded.

* If you turn on "Set Station Settings By Platform" on the Options menu
you can create a different schedule for each platform.
* If you turn on "Minimize Units of Time on Schedule" on the Options menu
you can set the schedule times down to the minute.

Points Settings

When a train running the Schedule Wizard reaches points you can choose from
the following options.

Straight ： The train will pass straight over the points when it reaches them.
Branch ： The train will branch off from the points when it reaches them.

00:00 -
23:59 Specify the time the train will proceed down the branch track.



* Branch settings can only be set when "Set Branch Time in Point Settings"
under Options is turned on.
* If you turn on "Minimize Units of Time on Schedule" on the Options menu
you can set the branch schedule time down to the minute. 

Copyright 2008 ARTDINK. All Rights Reserved.



Map Construction Mode

Rail <Back to Top
Page

Select "Rail" from the main menu to open the Track menu.
You can lay and remove track from the Track menu.

Laying Mode
   ・Flat Track (Straight / Curved)
   ・Flat Track (Points)
   ・Flat Track (Tunnel)
   ・Gradated Track
Removal Mode

Laying Mode ▲TOP

Flat Track (Straight / Curved)

Click the "Laying Mode" button and then click "Flat Track" to start laying flat
track.
"Flat Track" allows you to lay straight or curved track across terrain of a
uniform height.

Click the point you want to start laying track from and then try moving the cursor.
You'll see yellow track (laying guide) leading from the starting point to the
cursor. Click again and the displayed track will be laid. (The track will be
displayed in red over locations in which it cannot be laid.)
If you want to lay elevated or underground track use height cut or the height bar
next to the track image to select the height before laying.

* You can right click to cancel the laying guide.



Flat Track (Points)

With construction of flat track turned on
click on already laid track and a temporary
point will be created in yellow on the track.
Click the same spot again to cycle through
the point types.
Once you have selected the type of point you
want to place move the cursor to extend the
track and then click to place the point and
connecting track. (The point will be
displayed in red over locations in which it
cannot be placed.)

There are numerous different types of point,
each of which should be used depending
upon circumstances. At a crossing, unlike
points, the track does not branch. (A cross-
shaped crossing allows two flat tracks to
cross each other.)

Points Left Curve (Turn
Out) Siding Single Crossing

Double Crossing Crossing Crossing (Cross-Shape)



Flat Track (Tunnel)

If you lay track toward a mountain a tunnel
will automatically be placed. However,
there are limitations on the places in which a
tunnel entrance can be placed - the mountain
face must be at a 45 degree angle to the
ground. (The tunnel will be displayed in red
over locations in which it cannot be placed.)

Gradated Track

Click "Laying Mode" and then select
"Gradated Track" to lay gradated track.
"Gradated Track" can be used to lay track at
varying heights.

Right click to decide facing, and then move
the cursor to the desired location and click to
place the gradated track. (The track will be
displayed in red over locations in which it
cannot be placed.)
You can also use the height cut or height bar
next to the track image to freely adjust the
height of gradated track. This allows
sections of elevated track to be linked
together, or underground tracks to be linked
with those on the surface.

Removal Mode ▲TOP

Click "Removal Mode" to enable removal of
track.

Place the cursor over the area you want to
remove and click to remove the track.

* If you select "Turn On Removal Via
Area Select" from the Options menu you



can select an entire area from which to
remove all track. Area select is performed
by clicking the start and end points of the
removal area.
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Select "Station" from the main menu to open the Station menu.
From the Station menu you can build and remove stations, station concourses and
material depots.

Construction Mode
   ・Station
   ・Station Concourse
   ・Material Depot
Removal Mode

Construction Mode ▲TOP

Station

Click "Construction Mode" and then click one
from "Rural Station," "Elevated Station,"
"Underground Station" and "Control Hub" to
build a station.
At stations, people can board or disembark,
and freight can be loaded or unloaded from
trains.

Click to select "Station Size" and "Number of
Platforms," right click to select station facing,
move the cursor to the location in which you
wish to build the station and click to start
construction.
The height of elevated and underground
stations can also be adjusted using the height
bar next to the image of the station (The station
will be displayed red in locations in which it
cannot be built).

Rural
Station

The area around a rural station
will develop more slowly than
that of other station types.



Elevated
Station

The area around an elevated
station will develop more
quickly than that of other station
types. This type of station can
also be built on high ground.

Underground
Station

Can only be built underground.
Underground stations will
facilitate above-ground
development.

Control Hub

A station at which materials
can be loaded or unloaded.
Even if you have passenger
trains stop here they will
generate no profits for you.

Station Concourse

Click "Construction Mode" and then click
"Station Concourse 1" or "Station Concourse
2" to create a concourse in front of a station.
A station concourse will facilitate
development around the attached station.

Right click to select concourse facing and
then move the cursor to the location in which
you wish to build it and click to start
construction (The concourse will be
displayed red in locations in which it cannot
be built).

Material Depot 

Click "Construction Mode" and then click
"Materials Depot (S)," "Materials Depot
(R)" or "Materials Depot (L)" to create a
materials depot.
Materials depots can be used to store
materials.

Right click to select materials depot facing



and then move the cursor to the location in
which you wish to build it and click to start
construction. If you line the height cut up
with underground you can build material
depots underground anywhere aside from
beneath mountains. (The concourse will be
displayed red in locations in which it cannot
be built.)

Removal Mode ▲TOP

Click "Removal Mode" to activate removal of buildings.

Place the cursor over the building you wish to remove and click to remove it.
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Select "Construction" from the main menu to open the Construction menu.
The Construction menu allows you to build and remove buildings from the map.

Construction Mode
Removal Mode

Construction Mode ▲TOP

Click "Construction Mode" to active creation of buildings.

Click "Type of Building" and "Building Name" to select them, right click to
decide the facing of the building, then move the cursor to the location in which
you wish to perform the construction and click to begin the work (The building
will be displayed red in locations where it cannot be built).

* Types of buildings can also be cycled through by clicking on the building
view.

Materials
Factory ：Can create building materials.

Public Facility ： Includes schools and parks. As these are public facilities they
will not make any profit for you.

Shop ：Mainly includes buildings that increase commerce values.
Hotel ：Mainly includes buildings that increase commerce values.



House ：Mainly includes buildings that increase population.
Office
Building ：Mainly includes buildings that increase business values.

High Rise
Building ：

Mainly includes buildings that increase business values.
It will take a number of weeks to complete construction of a
high rise building.

Super High
Rise Building ：

Mainly includes buildings that increase business values.
It will take a number of weeks to complete construction of a
super high rise building.

Entertainment
Facility ：Mainly includes buildings that increase leisure and culture

values. 

Sports Facility ：Mainly includes buildings that increase leisure and culture
values. 

Landmark ： Includes buildings that add character to your map.
Super
Structure ： Includes airports and ports.

Tree ： Includes trees.
Coast ： Includes lakes, breakwaters etc.
Road ： Includes roads etc.

* Click on a high rise building or super high rise building to open a menu
allowing their height to be adjusted.
* Tree, Coast and Road options are only available in Map Construction.
* During Map Construction no materials are required in order to build
anything.
* If you select "Turn On Construction Via Area Select" from the Options
menu you can select an entire area in which to build "House" and "Office
Building" constructions. Area select is performed by clicking the start and
end points of the construction area.

Removal Mode ▲TOP

Click "Removal Mode" to activate removal of buildings.

Place the cursor over the building you wish to remove and click to remove it.
You can only remove buildings that you can also build from the Construction
menu.

* If you select "Turn On Removal Via Area Select" from the Options menu
you can select an entire area from which to remove all buildings. Area select
is performed by clicking the start and end points of the removal area.



If you choose to build a new building on top of an existing one removal ⇒
construction will automatically be performed. This cannot be performed on top
of a Public Facility. If you wish to remove a Public Facility you must do so
manually.
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Click "File" from the main menu and the File menu will open.
The File menu allows you to start a new game or load a game currently in
progress.

Top Point Controls
Create Flat Land
Initialize

Top Point Controls ▲TOP

Click on "Top Point Controls" to open the
Top Point Controls window.
From here you can make the block of terrain
under the cursor higher or lower.

・Altering Terrain
With the Top Point Controls window open
click on the map and the terrain under the
cursor will increase in height. If you click on
the map while holding down [Space] the
terrain under the cursor will lower in height.

* You can also roll the mouse wheel up or
down while holding down [Space] to alter
the height of the terrain.

・Maximum and Minimum Height
Adjust the "Maximum Height" value or click
to adjust the bar below it on the left to set the
highest point to which the terrain can be
altered.
Adjust the "Minimum Height" value or click
to adjust the bar below it on the right to set
the lowest point to which the terrain can be
altered.



・Undo and Redo
Click on "Undo" or on the bar beneath it to
undo / redo changes to terrain.

Create Flat Land ▲TOP

Click on "Create Flat Land" and the Create
Flat Land window will open.
From here you can transform the terrain under
the cursor into level, flat land at the specified
height.

・Altering Terrain
With the Create Flat Land window open click
on the map and the terrain under the cursor
will be transformed into flat land at the
specified height.

* You can also press [Space] to flatten the
land. Hold down [Space] and move the
cursor to smoothly create a wide area of
flat, level land.

・Height of Flat Land
Adjust the "Height of Flat Land" value or
click to adjust the bar below it to set the
height of the flat land created.
Also, if you set "Height of Flat Land" to "-",
rather than selecting a specific height you can
instead create a slope linked to the height of
the terrain around the outside of the cursor.

・Undo and Redo
Click on "Undo" or on the bar beneath it to
undo / redo changes to terrain.

Initialize ▲TOP

Click "Initialize" and the Initialize window will open.
From here you can remove all buildings from the map or turn the entire map into
flat, level land.



・Initialize Building
Click the "Remove All Buildings" button and
a confirmation message will be displayed.
Select "Yes" to remove all buildings from
the map.

・Initialize Flat Land
Click the "Make Everything Flat" button and
a confirmation message will be displayed.
Select "Yes" to remove all buildings from
the map and then make the entire map level 2
flat land.

・Initialize Water
Click the "Make Everything Ocean" button
and a confirmation message will be
displayed. Select "Yes" to remove all
buildings from the map and then make the
entire map level 0 ocean.
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Select "Market" from the main menu and the Market menu will open,
From this menu you can buy and sell stock, take out a loan or sell off subsidiary
companies.

Share Exchange
Bank
Real Estate Sale

Share Exchange ▲TOP

Click on the "Share Exchange" button to display the share exchange screen.
Here you can buy and sell stocks.

Click on the "Buy Stocks" button to buy stock, and the "Sell Stocks" button to sell
stock.
Click to select the name of the stock you wish to trade then click on the "Shares
to Purchase" or "Shares to Sell" to select the number of stock to deal in.
Then click on the "Purchase Stock" or "Sell Stock" buttons to purchase or sell the
indicated number of stock.

* Company names, details of their business and stock prices are fictitious
and totally unrelated to any real companies or stock.



Bank ▲TOP

Click on "Bank" to display the bank screen.
From here you can take out a loan.

Click to select "One Year Loan" or "Two
Year Loan" and then click "Loan Amount" and
enter the amount you want to borrow.
Then click the "Take Out Loan" button to
borrow the indicated amount.

* You can borrow an infinite amount of
money in Map Construction.
* The loan amount will be taken
automatically from your capital on the
repayment date.
* Click on the loan list and click the
"Repay Loan" button to immediately pay
back the corresponding loan.

Real Estate Sale ▲TOP

Click on "Real Estate Sale" to display the
real estate screen.
From here you can sell buildings belonging
to your company.

Click on the type and name of the building
you want to see and then click on "Sell
Property" to sell buildings that belong to
your company.
You can also click on "Jump to Property
Location" to jump the screen to the location
of that property.
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Select "Option" from the main menu and the Option menu will open.
From the Options menu you can change various options relating to game display
and settings.

Side Menu
   ・Satellite Display
   ・Display Grip
   ・Display Target Information
   ・Display Height Cut Bar
   ・Tracking Device
   ・Timer
Map Display
   ・Display Water Surface
   ・Grid
   ・Image Clipping Settings
   ・LOD
Weather
   ・Time-Based Palette Changes
   ・Display Weather
Time
   ・Time Stops When Window Opens
   ・Pause Prior To Event Occurring
   ・Pause Before Final Accounts (1st Jan)
   ・Boost Maximum Passage of Time Speed
Schedule
   ・Set Station Settings by Platform
   ・Set Branch Time in Points Settings
   ・Display Simple Schedule
   ・Display Train Numbers
   ・Mark Point Branches
   ・Restore Time on Schedule Wizard
   ・Display Time on Schedule Wizard
   ・Minimize Units of Time on Schedule
   ・Expand Maximum Number of Trains
Data Display
   ・Attach Description to Name of Stocks
   ・Attach Description to Train
   ・Colour Company Buildings



   ・Limit Subsidiary List to Within Screen
   ・Sort Train Purchases in Descending Order
   ・Select Language
Area Select
   ・Turn On Removal Via Area Select
   ・Turn On Construction Via Area Select
System
   ・Sound
   ・HDTV Safe Area
Map Creation
   ・Simulate Development

Side Menu ▲TOP

Satellite Display

Turn display of the satellite image on or off.

・Increase Transparency
Increase the transparency of the displayed satellite image.
This option can only be clicked and altered when "Satellite Display" is turned
on.

・Auto Refresh Display
The satellite image will automatically refresh.
This option can only be clicked and altered when "Satellite Display" is turned
on.

Display Grip

Turn display of the grip on or off.
The grip allows more precise control of the camera.

・Frame Rate
From the data displayed on the grip, the data indicating horizontal rotation will
be replaced with display of frame rate.
This option can only be clicked and altered when "Grip Display" is turned on.

Display Target Information



Turn display of target information on or off.

・Display Target Name
The name of a building beneath the cursor will be displayed.
This option can only be clicked and altered when "Display Target Information"
is turned on.

・Display Target Data
The data of a building beneath the cursor will be displayed.
This option can only be clicked and altered when "Display Target Information"
is turned on.

Height Cut Bar

Turn display of the height cut bar on or off.
Height cut functions can only be used when the height cut bar display is turned
on.

Tracking Device

Turn display of a menu allowing control of the tracking device on or off.
Tracking device functions can only be used when the menu allowing control of
the tracking device is turned on.

Timer

Turn display of the stop timer on or off.

Map Display ▲TOP

Display Water Surface

Turn display of the water surfaces on or off.

Grid



Turn grid display over the map on or off.

Image Clipping Settings

Set the maximum distance at which buildings will be displayed.
Buildings beyond the set distance will not be displayed.

* This setting also affects limits placed on zooming the camera.

・Clipping (Close Scenery)
Only buildings in the direct vicinity will be displayed. This setting displays the
least number of buildings.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

・Clipping (Intermediate Scenery)
Buildings within an intermediate range will be displayed.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

・Clipping (Distant Scenery)
Buildings will be displayed a considerable way into the distance.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.

・Clipping (Horizon Scenery)
Buildings will be displayed even further away than on the "Distant" setting. This
setting displays the most number of buildings.
This option can only be clicked and altered when "Image Clipping Settings" is
turned on.
You can also only select one from "Clipping (Close Scenery)," "Clipping
(Intermediate Scenery)," "Clipping (Distant Scenery)" and "Clipping (Horizon
Scenery)" under this option.



LOD

Turn simplified display of distant buildings on or off.
With this option turned on distant buildings will be displayed in a simplified
form, helping to improve frame rate.

Weather ▲TOP

Time-Based Palette Changes

Turn palette changes due to time and seasons on or off.
If turned off, the current state at that time will be maintained.

Display Weather

Turn display of the weather on or off.
If turned off the weather will remain clear at all times.

・Display Rain
Turn display of rain on or off.
This option can only be clicked and altered when "Display Weather" is turned
on.

・Display Snow
Turn display of snow on or off.
This option can only be clicked and altered when "Display Weather" is turned
on.

Time ▲TOP

Time Stops When Window Opens

Turn in-game time stopping when the main menu is opened on or off.
However, even when turned off opening the File menu or Schedule menu will
stop in-game time.

* In-game time will also stop in Map Construction Mode when the height
adjustment menu for high rise and super high rise buildings is opened.



Pause Prior To Event Occurring

Turn automatic event pausing on or off.
Events include "attaining a capital goal" and "game over."

Pause Before Final Accounts (1st Jan)

Enable/disable the game automatically pausing at 0:00 on 1st January game time.
The final accounts for the year are performed at the end of 31st December each
game year.

Boost Maximum Passage of Time Speed

Increase the passage of time beyond even that possible using the slide bar
displayed above the time in-game.
However, the frame rate will fall with this setting turned on.

Schedule ▲TOP

Set Station Settings by Platform

Enable/disable setting individual schedules for each platform in a station.

Set Branch Time in Points Settings

Enable/disable the ability to set a time for the train to depart from a point after
selecting "Branch" in point settings.

Display Simple Schedule

Turn a simple schedule display for stations on or off.

Display Train Numbers



Turn display of train numbers on or off.

・Display Running Time
Display the running time for the train since it left its last station.
This option can only be clicked and altered when "Display Running Time" is
turned on.

Mark Point Branches

Turn display of branch marks on or off in point settings.

・Display Everything
All branches will be marked in point settings.
This option can only be clicked and altered when "Mark Point Branches" is
turned on.

Restore Time on Schedule Wizard

Enable/disable the ability to restore time on the Schedule Wizard.
When turned on you will be able to "not apply the Wizard changes and return
time to the point the wizard was opened" and "apply the Wizard changes and
return time to the point the wizard was opened" after using the Schedule Wizard.

Display Time on Schedule Wizard

Turn passed-through stations display on or off during the Schedule Wizard.

Minimize Units of Time on Schedule

Enable/disable the ability to stipulate time down to the minute on "Departure
Time," "Point Settings," "Branch" etc.

Expand Maximum Number of Trains

Select from being able to use 40 or 60 trains at once.
Trains numbered 41 - 60 acquired with this turned on cannot be removed or sold
if the option is then turned off.



If this option is then turned back on, the trains can be controlled again as normal.

Data Display ▲TOP

Attach Description to Name of Stocks

Enable/disable the option to attach a description to the name of stocks in the
Market menu.

Attach Description to Train

Enable/disable the option to attach a description to a train in the Train menu.

Colour Company Buildings

Enable/disable the colouring of buildings belonging to your company.

Limit Subsidiary List to Within Screen

Enable/disable limiting the subsidiary companies displayed during a property
sale in the Market menu to those currently displayed on the screen.

Sort Train Purchases in Descending Order

Select ascending or descending order when making a train purchase from the
Train menu.

Select Language

You can choose the game text language from English, French, Italian, German
and Spanish.

Area Select ▲TOP

Turn On Removal Via Area Select



Allow entire areas of track and buildings, from the Track and Construction
menus respectively, to be selected and removed at once.

Turn On Construction Via Area Select

Allow entire areas to be selected and built up with "Houses" and "Office
Buildings" from the Construction menu.

・Random Construction
When an area is selected for construction the actual buildings placed within it
will be random.
This option can only be clicked and altered when "Turn On Construction Via
Area Select" is turned on.

System ▲TOP

Sound

Turn in-game sound on or off.

・Music
Turn music on or off.
This option can only be clicked and altered when "Sound" is turned on.

・SE
Turn sound effects on or off.
This option can only be clicked and altered when "Sound" is turned on.

HDTV Safe Area

Enable/disable menu displays in the centre of the screen.
Use this if, when outputting your PC to your TV the menu sticks off the edge of
the screen.

Map Creation ▲TOP

 ・Simulate Development



Your city will develop as time passes.
Turn this option off and you can allow time to pass without your city developing
or degenerating, allowing you to set up schedules etc. in a stable environment.
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Map Construction Mode

Help <Back to Top
Page

Select "Help" from the main menu to open the Help menu.
From here you can open the online manual and the official site.

Manual
Home Page
Version Information

Manual ▲TOP

Open the "A-Train 8" online manual (this manual.)

Home Page ▲TOP

Open the "Degica Co., Ltd." Official Home Page.

Version Information ▲TOP

Check the version information for your copy of "A-Train 8."

Copyright 2008 ARTDINK. All Rights Reserved.



Tool Bar / Other Functions

Tool Bar <Back to Top
Page

You can use the tool bar in the top right of the screen to toggle certain functions
on / off.

Satellite
Grip
Grid
Target Information
Point North
Menu Display Off
Height Cut
Train Tracking
Timer

Satellite ▲TOP

Click to toggle display of the satellite on /
off.

Click or drag on the satellite to move the
camera to that location.
You can also drag the four edges to rotate
the camera.

Grip ▲TOP

Click to toggle display of the grip on /
off.



Drag ① to change the tilt of the camera,
drag ② to rotate the camera and drag ③
to alter the camera zoom.

Grid ▲TOP

Click to toggle display of a grid on the map
on / off.

Target Information ▲TOP

Click to toggle display of target information on / off.

With Target Information turned on information related to selected buildings will
be displayed.
Also, if you have "Display Target Data" turned on in the Options menu, other
building data (sale price etc.) will also be displayed.

Point North ▲TOP

Click to point the camera to the north.

Menu Display Off ▲TOP

Click to hide all of the menus currently open on the screen.

Click on the screen when menus are hidden and the menus will appear again.



Height Cut ▲TOP

Click to toggle display of the height cut on /
off.

Height cut will turn off.
Height cut will turn on.

Train Tracking ▲TOP

Click to toggle display of the satellite on / off.

Train tracking will be turn off.
The camera will track a train.
The camera will look out from a train window.

* Toggling between off, train tracking and train window mode is also
possible from the train tag displayed on the bottom right of the screen.

Timer ▲TOP

Click to toggle display of the timer on / off.

Click the arrow to select year and month
and then click the date to set the timer.
When game time reaches 0:00 on the day
the timer is set for the game will
automatically pause.
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Tool Bar / Other Functions

Stn. Settings / Points Settings <Back to Top
Page

Click on a station or point on the map to open "Stn. Settings" or "Point Settings."

Stn. Settings
Point Settings

Stn. Settings ▲TOP

Click any station on the map and you can alter its schedule settings.
If there is more than one station in the same location but at different heights each
click will cycle to the next station located there.

One Hour
Stop ：Depart one hour after stopping in the station.

Pass
Through ：Don't stop in the station

Passage ：Depart after train coming from the other direction clears the
station, (including pass throughs).

Wait for
Overtake ：Depart after a train coming from the same direction clears the

station. (including pass throughs).
Wait for Depart after the next train arrives in the station (not including



Arrival ： pass throughs).
Departure
Time ：Use this setting to indicate a specific departure time.

Depart at
00:00 Set the time for the first train of the day.

00:00
Interval Set the interval between trains departing the station.

Daily Select the days to apply these settings to.
Monthly Select the months to apply these settings to.

Stop ： The train will not leave the station after arriving.

Straight ： The train will continue in the direction it entered the station in.

Reverse ： The train will reverse and travel back in the direction it came
from.

Do Nothing ：Do not load or unload cargo.

Load ：
If the freight train has space and there is a viable factory or
materials depot within range then materials will be loaded onto
the train.

Unload ：
If the freight train has materials and there is a viable factory or
materials depot within range then materials will be unloaded
from the train.

Load &
Unload ：

If the conditions for loading are met materials will be loaded,
and if the conditions for unloading are met materials will be
unloaded.

* If you turn on "Set Station Settings By Platform" on the Options menu
you can create a different schedule for each platform.
* If you turn on "Minimize Units of Time on Schedule" on the Options menu
you can set the schedule times down to the minute.

Points Settings ▲TOP



Click any track point on the map and you can alter its schedule settings.
If there is more than one point in the same location but at different heights each
click will cycle to the next point located there.

Straight ： The train will pass straight over the points when it reaches them.
Branch ： The train will branch off from the points when it reaches them.

00:00 -
23:59 Specify the time the train will proceed down the branch track.

* Branch settings can only be set when "Set Branch Time in Points
Settings" under Options is turned on.
* If you turn on "Minimize Units of Time on Schedule" on the Options menu
you can set the branch schedule time down to the minute.
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Tool Bar / Other Functions

Shortcut Keys <Back to Top
Page

"A-Train 8" allows use of keyboard short cut keys.

Short Cut Keys
[Space] Key

Short Cut Keys ▲TOP

The following keys act as short cut keys in "A-Train 8."

* The characters in <>correspond to the keys on the number pad.

Pause Time <*>
Close All Menus <0>
Toggle Height Cut On / Off [h]
Raise Height Cut <+>
Lower Height Cut <->
Point North [n] or <5>
Scroll Map Up <8> or [e]
Scroll Map Down <2> or [x]
Scroll Map Left <4> or [s]
Scroll Map Right <6> or [d]
Scroll Map Up-Left <7> or [w]
Scroll Map Up-Right <9> or [r]
Scroll Map Down-Left <1> or [z]
Scroll Map Down-Right <3> or [c]
Viewpoint Close Distance [Home]
Viewpoint Long Distance [End]
Viewpoint Tilt Up [Up（↑）]
Viewpoint Tilt Down [Down（↓）]
Viewpoint Rotate Target Left [Left（←）]
Viewpoint Rotate Target
Right [Right（→）]

Viewpoint Pan Left [<] or [,]



Viewpoint Pan Right [>] or [.]
Scroll Bar Up [PageUp]
Scroll Bar Down [PageDown]
Rotate Building / Project [Tab]
Train Tracking <.>
Music and Sounds [M]

[Space] Key ▲TOP

[Space] can be used to perform certain actions more smoothly, such as editing
terrain.

・Elevated Stations, Track
When placing an elevated station or track you can hold down [Space] and use the
mouse wheel to adjust the height of the building or track.

・Camera
At any time that you have control over the camera hold down [Space], right click
and drag the mouse to pan the camera.

・Top Point Controls (Map Construction Only)
With "Top Point Controls" open in the Editor menu you can hold down [Space]
and use the mouse wheel to alter the terrain under the cursor.

・Create Flat Land (Map Construction Only)
With "Create Flat Land" open in the Editor menu press [Space] to flatten the
terrain under the cursor.
You can also hold down [Space] and move the mouse to continuously create flat
land.

・High Rise, Super High Rise Buildings (Map Construction Only)
With the cursor placed over a high rise or super high rise building hold down
[Space] and use the mouse wheel to adjust the height of the building.
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TIPS

Varieties of Train <Back to Top
Page

Varieties of Train
Passenger Trains
Freight Trains

Varieties of Train ▲TOP

Trains are broadly divided into two categories, passenger trains and freight
trains.
Passenger trains make money by carrying people and freight trains make money
by carrying materials.

Passenger
Trains

Commuter Passenger Load :
200%

High Speed
Commuter

Passenger Load :
180%

Passenger Passenger Load :
160%

Express Passenger Load :
140%

Limited
Express

Passenger Load :
120%

Super
Express

Passenger Load :
110%

Underground Passenger Load :
200%

Freight
Trains

Freight Cargo Load : 100%
Express
Freight Cargo Load : 100%

Passenger Trains ▲TOP

Passenger trains carry people from station to
station.



Passenger trains cannot carry materials.

There are no limits on trains outside of those
applied to passenger and freight types.
Therefore, you can place an underground
train on above ground tracks or express and
limited express trains on inner city track.

However, super express trains can only be
used if you first use the Project menu to bring
bullet train or maglev track to your city.

Fright Trains ▲TOP

Freight trains carry materials from station to
station.
Freight trains cannot carry passengers.

Freight trains can use all stations and control
hubs load or unload materials from factories
or material depots close to those locations.
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Materials <Back to Top
Page

What Are Materials?
Obtaining Materials
Using Materials

What Are Materials? ▲TOP

In "A-Train 8" there is a game element
called "materials."
Materials are vital in order to build anything
while playing "A-Train 8."
Each building requires a fixed amount of
materials, and if the requisite amount of
materials is not located close to the intended
building site you will not be able to erect
that building.

Obtaining Materials ▲TOP

There are a number of ways in which you can obtain materials.
Use the one best suited to circumstances.

・Materials Factory
Create a Materials Factory and materials will
start to be automatically created within the
confines of the factory (Though not on
weekends and holidays).
However, the only way to actually make use of
the materials created by a factory is to first
transport them using a freight train.

・Port
Create a Port and materials will automatically
start to be shipped into the port.
However, the only way to actually make use



of the materials shipped into a port is to first
transport them using a freight train.
* If there is no clear route from the map
edge to the port then ships will not appear
on the map and materials will be not
shipped to the port.

・From outside the map
If you send a freight train outside of the map
without any cargo aboard it will return
carrying a cargo of materials.

Using Materials ▲TOP

Materials obtained from factories and ports
will initially be placed in those locations.
However there is no way to use materials in
this state.
You must first use a freight train to move the
materials from the factory or port to a
"Material Depot," from where they can then
be used.

Materials also have a limited effective
range. Materials can only be used within 15
blocks of where they are stored.
In the same way, when a train carries
materials into a station there must be a
materials depot within 15 blocks of the
station in order to load or unload materials.
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TIPS

Locations in Which Construction Can / Cannot
be Performed

<Back to Top
Page

Locations in Which Construction Cannot be Performed
Special Buildings

Locations in Which Construction
Cannot be Performed ▲TOP

The locations in which buildings, stations, track and other buildings can be
placed are fixed.
You cannot build in the following locations.

・On top of stations or track
You cannot build on top of existing stations
and track. You will first have to use the
Station menu or Track menu to remove the
existing structures.

・On top of public facilities
You cannot build on top of existing public
facilities. You will first have to use the
Construction menu to remove the existing
structures.

・On water
You cannot build on top of water.

* Marinas and certain port sections can be
build on water.

・Mountain slopes



You cannot build on mountain slopes.
* Certain ski slopes can be built on
mountain slopes.

・Underground
You cannot build underground.

* Underground Stations can be built
anywhere underground aside from beneath
mountains.
* Underground Material Depots can be
built anywhere underground aside from
beneath mountains.

Special Buildings ▲TOP

Certain special buildings have additional conditions that must be fulfilled prior
to being able to build them.

・Marina
A marina can only be built on a block
comprised of 2x1 land and 2x2 water.

・Port
A port can only be built on a block comprised
of 5x2 land and 5x1 water.

* You can have a maximum of 4 ports on
the map.

・Ski Slope



A ski slope can only be built on a 1x2 block,
with a height difference of 2 within that block.

・Airport
An airport can only be built on a 12x5 block
with 10-20 blocks of free space at the front
and back for runways.

* You can only have 1 airport on the map at
once.

・Underground Station
Underground Stations can only be build
underground, anywhere aside from beneath
mountain slopes.

Copyright 2008 ARTDINK. All Rights Reserved.



TIPS

Effective Laying of Track <Back to Top
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Loop Line
Overtake Line
Complex Lines
   ・Single Cross
   ・Raised Track

Loop Line ▲TOP

Create a ring of track and send trains around it in the same direction. You will
never have to worry about trains backing up or interfering with each other.

Overtake Line ▲TOP



Creating one section of multiple tracks along a long length of single track and
then adjusting the schedule accordingly will allow two trains to run along this
track.

Complex Lines ▲TOP

Single Crossing

Use a single crossing and divide the track into inbound only and outbound only
track. Then you can run trains along them without any fear of them interfering
with each other.

Raised Track



Using raised track to add new tracks will reduce the risk when trains turn back,
lowering the possibility of trains backing up or interfering with each other.
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Compensating for Slow Frame Rate <Back to Top
Page

If the game suffers from a slow frame rate during play try adjusting the settings of
the following options.

A-Train 8 Settings
Options Menu

A-Train 8 Settings ▲TOP

If the game suffers from a slow frame rate during play try the following set up
from the Settings menu.

・Multi-Sampling ：None
・Textures ： Low
・Draw Quality ：Normal
・Boot in Full
Screen Mode ：Check

・Resolution ： 1024×768×16

Options Menu ▲TOP

If the game suffers from a slow frame rate during play try the following set up
from the Options menu.

・"Display Map" - "Display
Water Surface" ：Off

・"Display Map" - "Image
Clipping Settings" ：On / Clipping (Close

Scenery)
・"Display Map" - "LOD" ：On
・"Weather" - "Display
Weather" ：Off
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